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EDITORIAL
This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE!

T

hat's right, folks. Full Circle is six years old this
month. Incredible! Never, when I started FCM all those
years ago, did I imagine that it would still be going strong six years later. I can't
stress enough that every issue is created by a team of folks, not just me, so a BIG
thanks to all of them. Their names are listed on the last page of every issue and at the
top of each article. My thanks also go out to the many translation teams around the
world.
The one thing I like to do each birthday issue is to have a survey where you, the
readers, can give us your opinion on FCM. What would you like to see more/less of?
What do you like/dislike? Full details are on page 38; the survey is at:
http://goo.gl/hR7zc.
I'm sure you Python fans will know about the Special Editions that Robin Catling has
been putting together (which, by the way, is up to volume six). Well, he's now creating a
series of Special Editions from the LibreOffice series, so, if you've been wanting to
gather them into one handy dandy issue, volume one is up on the main Full Circle site.
The easiest way to find the Special Editions is to use the search box on the site.
Anyway, I shan’t keep you any longer. Enjoy the issue, and please fill in the survey!
All the best, and keep in touch!

Ronnie

ronnie@fullcirclemagazine.org

Full Circle Podcast
Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.
Hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
http://fullcirclemagazine.org
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UBUNTU NEWS

Written by The Ubuntu News Team

CHANGES IN UBUNTU
RELEASES DECIDED BY THE

UBUNTU TECHNICAL BOARD

T

he Ubuntu Technical Board
announce their decision to
change support for non-LTS
releases from 18 to 9 months, and
the adoption of a mechanism to
allow users to continuously track
the development focus without
explicitly upgrading from release
to release.
http://fridge.ubuntu.com/2013/03/
19/changes-in-ubuntu-releasesdecided-by-the-ubuntu-technicalboard/
Also read the follow-up post by
Rick Spencer, Vice President of
Ubuntu Engineering, for his
comments on the decisions by the
Ubuntu Technical Board, and how
they will impact users:
http://fridge.ubuntu.com/2013/03/
19/ubuntu-technical-board-looksat-shuttleworths-proposal-forrelease-managementmethodology/
Visit the following articles for

some other takes on the
announcement:
Ubuntu Technical Board Meeting
Decisions Regarding The New
Release Proposals http://www.webupd8.org/2013/03
/ubuntu-technical-boardmeeting.html
Ubuntu To Halve Support Window
for 'Regular' Releases http://www.omgubuntu.co.uk/201
3/03/ubuntu-to-halve-supportwindow-for-regular-releases
Canonical to halve support for
standard Ubuntu releases http://www.linuxuser.co.uk/news/c
anonical-to-halve-support-forstandard-ubuntu-releases

UBUNTU MEMBERSHIP
BOARD CALL FOR
NOMINATIONS

E

lizabeth Krumbach, on behalf
of the Community Council,
makes a call out for restaffing the
Membership Board, which is
responsible for voting new Ubuntu
members. The Membership Board
full circle magazine #72

is in need of 9 Ubuntu Members
with a good community track
record and enough time available
for meetings once a month.
Nominations will be accepted
through Friday April 5th at 12:00
UTC for ubuntu-membershipboards at lists.ubuntu.com
http://fridge.ubuntu.com/2013/03/
22/ubuntu-membership-board-callfor-nominations/

CANONICAL AND CHINESE
STANDARDS BODY
ANNOUNCE

UBUNTU

COLLABORATION

T

he CSIP (China Software and
Integrated Chip Promotions
Centre), National University of
Defense Technology (NUDT) and
Canonical join forces to create
Ubuntu Kylin, a China-focused
Ubuntu desktop system. This
announcement represents the first
step into the government’s five
year plan to promote open source
software and accelerate the
growth of the open source
ecosystem within the country.
4

http://www.canonical.com/content
/canonical-and-chinese-standardsbody-announce-ubuntucollaboration
This story has also been covered in
the wider press:
China to create home-grown
operating system http://www.bbc.co.uk/news/techn
ology-21895723
Ubuntu tapped by China for
national operating system http://www.theregister.co.uk/2013
/03/22/china_makes_linux_os_with
_canonical_help/
China chooses Ubuntu for a
national reference OS coming in
April http://www.engadget.com/2013/0
3/23/china-chooses-ubuntu-for-anational-reference-os-coming-inapril/
Goodbye Windows: China to create
home-grown OS based on Ubuntu http://arstechnica.com/informatio
n-technology/2013/03/goodbyecontents ^
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windows-china-to-create-homegrown-os-based-on-ubuntu/

UBUNTU 8.04 (HARDY
HERON) SERVER, 10.04
(LUCID LYNX) DESKTOP AND
11.10 (ONEIRIC OCELOT)
REACHING END OF LIFE ON
MAY 9 2013

A

dam Conrad, on behalf of the
Ubuntu Release Team,
announces the formal End of Life
(EOL) dates of Ubuntu 8.04 (Hardy
Heron) server, 10.04 (Lucid Lynx)
desktop and 11.10 (Oneiric Ocelot)
desktop and server.
http://fridge.ubuntu.com/2013/03/
29/ubuntu-8-04-hardy-heronserver-10-04-lucid-lynx-desktopand-11-10-oneiric-ocelot-reachingend-of-life-on-may-9-2013/

UDS 13.05: UBUNTU’S
SECOND ONLINE DEVELOPER
SUMMIT

M

ichael Hall announces the
next Ubuntu Developer

Summit May 14th-16th, 2013 from
14:00 UTC to 20:00 UTC. He
encourages people to register a
blueprint and ask the track leads to
add a session for them. He also
outlines some improvements to
the Google+ Hangouts, the
plenaries, the schedule, summit
scheduler, and registration
processes.
http://mhall119.com/2013/04/uds13-05-ubuntus-second-onlinedeveloper-summit/

NEW UBUNTU MEMBERSHIP
BOARD MEMBERS

E

lizabeth Krumbach announces
the Ubuntu Membership Board
Members approved by the Ubuntu
Community Council. Zhengpeng
Hou, Mathieu Trudel-Lapierre,
Jared Norris, Eleanor Chen, and
Penelope Stowe are welcomed (or
welcomed back!) into the 1200 UTC
Membership Board and Iulian
Udrea, Javier Lopez, and Benjamin
Kerensa were welcomed (or
welcomed back!) into the 2200 UTC
Membership Board.

Many Thanks to the Ubuntu News
Team for their contribution this
month.
News this month comes from:
https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue309
https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue310
https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue311
https://wiki.ubuntu.com/UbuntuW
eeklyNewsletter/Issue312

Ubuntu 13.04 continues
Ubuntu's proud tradition of
integrating the latest and
greatest open source
technologies into a high-quality,
easy-to-use Linux distribution.
This release cycle has seen a
significant push toward daily
quality, which has allowed most
developers and users to
participate more actively
throughout the cycle, and we
feel this also shows in the final
quality of this release.
Along with performance
improvements to Unity, updates
to common desktop packages,
and updated core and toolchain
components, Ubuntu 13.04 also
includes the new Friends service,
to consolidate all social
networking accounts via Ubuntu
Online Accounts. Also included
is a tech preview of Upstart's
new user session feature.
Read more about the new
features of Ubuntu 13.04 in the
following press releases:
http://ubunt.eu/1304Server and:
http://ubunt.eu/1304Client

https://lists.ubuntu.com/archives/u
buntu-news-team/2013April/001777.html
full circle magazine #72
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Ubuntu Touch Follow-up

Written by Lucas Westermann

A

fter my article last month on
Ubuntu Touch, I received a
relative flurry of responses from
readers (more so than for any
other article I've ever written). Due
to the response, I thought it might
be nice to share readers’ responses
in a follow-up article. The first
weekend of April also saw a big
change in the TF101 Ubuntu Touch
packages, and I was finally able to
get the developer preview running
on my tablet. However, as hardly
any functionality exists at this
time, I will save a full-on review for
a later date (an official Beta
release, for example).
The first response I received
was from a reader who shared his
opinion that Ubuntu Touch
absolutely must have integrated
support for Google accounts
(Google Mail, Google Contacts,
Google Calendar (with emphasis
on the reminders), Google Maps
and Navigation). Upon reading the
article, I realised I had neglected to
mention anything of the sort. That
being said, I imagine Ubuntu will
ship with some form of mail client
(Evolution/Thunderbird). Google

Mail support was very effective in
either of those applications, the
last time I used them. Thunderbird
also offers the Lightning plug-in
for calendars, which works well
with Google Calendar. There are
also numerous plug-ins for
Thunderbird that allow the syncing
of contacts. As such, I think it
highly unlikely that Ubuntu Touch
releases will be lacking a tool with
similar features. That leaves
Google Maps and Navigation. My
fear is that Canonical will decide to
include some new map/navigation
tool, instead of trying to include
Google's tried-and-tested
applications. There is always the
argument “Google Maps can easily
be accessed through a browser”,
but it defeats the purpose of a
quick and handy maps tool. At this
point, all we can do is wait and see.

the reader's case, he mentioned
TouchPal's Keyboard, Dialer and
Contacts app. This does more than
just replace the keyboard, but also
offers a custom dialer and contacts
app. His reasoning for why this app
is worthwhile was because he
found typing on the typical
Android keyboard to be “slow,
boring and error-prone”. He found
the “swipe to type” method of
TouchPal's keyboard much more
intuitive, and, due to the learning
algorithm, less error-prone. The
reader also notes that while
TouchPal's keyboard app offers
predictive features, they are
turned off by default, and it's not
necessarily clear how to enable
them. According to a Sprint user
guide, sliding right on the space
bar enables predictive typing, and
sliding to the left disables it again.

This same reader also stated
that he wished to see a highly
functional/usable keyboard in
Ubuntu. While I haven't had issues
with the default Android
keyboards, there seems to be a
large number of Android users who
prefer keyboards such as Swype. In

The Dialer and Contacts apps
included in the TouchPal package
are useful for the reader, because
the default Contacts app tends to
lose data included in the Notes
sections of contacts when they
contain a lot of text. As the reader
creates these Contacts on the PC,
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it's impractical to deal with, and
TouchPal's Contacts and Dialer app
(one shortcut for both tools)
apparently does not suffer from
this limitation, and the reader once
again finds it more flexible and
easier to use.
The second email I received was
short and to the point. The reader
felt the possible lack of Aldiko (an
e-reader application), and Kindle
apps on Ubuntu Touch would be
something to consider. Now, I'm
not sure Aldiko will be
ported/available for Ubuntu Touch,
but I think Canonical would be
remiss if they didn't include some
form of Kindle app. Once again,
Amazon does allow reading of
Kindle books online (“Amazon
Cloud Reader”), but it's hardly an
ideal solution. That being said, the
list of dummy applications in the
Developer Preview does include an
Amazon store shortcut, which
makes me believe Ubuntu will do
its best to integrate Amazon
services. I would supply further
information about the apps
included, but, as the keyboard isn't
working properly, I can't connect to
contents ^
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the wireless, making nearly every
app throw “not connected” errors,
or disabling those features I'd be
interested in testing.
Lastly, I had a reader explain to
me that he wanted to install
Ubuntu Touch on a Samsung
Galaxy S III, but cited the Ubuntu
Wiki page where it was listed as a
“work in progress”. So, for anyone
else who was wondering
something similar, I say this: if
you're willing to give up a perfectly
functional device in order to install
a pretty much non-functional
Developer Preview just to see
what it looks like, you can
generally expect any of the Wiki
pages for your device to include
decent instructions. That being
said, Ubuntu Touch is not in an
alpha, beta, or release candidate
stage. It is quite literally a
snapshot of their demo device,
including multiple accounts you
can't access, a guest account you
need to use, and examples of
applications they want to include.
If, however, you have a second or
third Android device just sitting
around (such as my TF101), then
feel free to flash it and play around
a little, just don't expect to be
breathing new life into an old
device (just yet). Lastly, the Wiki

page is split up in this way:
• Working with phablet-flash
(official Ubuntu method, contains
just the Galaxy Nexus, and the
Nexus 4, 7 and 10);
• Working, but not available from
cdimage.u.c (unofficial ports,
maintained by the community, but
fairly functional); and
• Work-In-Progress (basically the
waiting point for any port that
hasn't yet gotten
unlocking/installing instructions,
working code or an image).
Unless you want to help debug
and develop, Work-In-Progress

devices are probably not worth
flashing.
On a completely unrelated
note. After my article on the
Rocksmith Real Tone Cable for
recording electric guitar, I had a
reader request an article or two on
using Audacity to record acoustic
guitar. These articles will happen
as soon as I have a working audio
interface available to me, and I will
be covering recording acoustic
guitar with a microphone, with
pickups, electric guitar (direct-in),
and with a microphone in front of
the amp. If all goes well, this will
happen within the next two issues

of FCM. If any musicians out there
have suggestions on audio
interfaces they have had working
with Ubuntu, or if anyone has
specific questions they'd like me to
cover in the articles, feel free to
email me at lswest34@gmail.com.
Please include the words “FCM
Guitar Article” in the subject line,
so I can separate them from usual
C&C emails.
I hope at least a few people
have found the reader responses
useful and/or interesting! I had
definitely never heard of the
TouchPal Keyboard, Dialer and
Contacts app. Got any questions?
Suggestions? Then feel free to
email me at lswest34@gmail.com.
Please include either “FCM” or
“C&C” in the subject line, so it
doesn't get lost in my inbox!

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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Programming In Python: Pt 43

Written by Greg Walters

L

ast time, we started a project
that would eventually use the
TvRage module that we created
the month before that. Now we
will continue the project. This time
we will be adding functionality to
our program: tweaking the
filename parse routine and adding
two fields (TvRageId and Status) to
the database. So, let’s jump right
in.

Series.s00e00

First, we will make the changes
to our import lines. For those who
are just joining us, I'll include the
ones from last time (shown top
right).

Our first pattern tries to catch
multi-episode files. There are
various naming schemes, but the
one we will support is similar to
'S01E03.S01E04'. We use the
pattern string
"(.*)\.s(\d{1,2})e(\d{1,2})\.s(\d{1,2})
e(\d{1,2})". This returns (hopefully)
five groups which consist of: the
series name (S[1]), season(S[2]),
episode number 1 (S[3]), season
(S[4]), and episode number 2 (S[5]).
Remember that the parens create
each group for returns. In the case
above, we group anything from the
first character up to the ".s", then
two numbers, skip the "e", then
two numbers, and repeat. So the
filename
"Monk.S01E05.S01E06.avi" returns

The lines after ‘import re’ are
the new ones for this time.
The next thing we will do is
rewrite the GetSeasonEpisode
routine. We are going to throw out
pretty much everything we did last
month, and make it more flexible
across the possible season/episode
schemes. In this iteration, we will
be able to support the following
schemes...
Series.S00E00

Series.S00E00.S00E01
Series.00x00
Series.S0000
Series.0x00

We will also fix any ‘missing
leading zero’ issues before we
write to the database.

full circle magazine #72

import os
from os.path import join, getsize, exists
import sys
import apsw
import re
#-----------------------------#
NEW LINES START HERE
#-----------------------------from xml.etree import ElementTree as ET
import urllib
import string
from TvRage import TvRage

the following groups...
S[1] = Monk
S[2] = 01
S[3] = 05
S[4] = 01
S[5] = 06

We are using only groups S[1],
S[2] and S[3] in this code, but you
can see where we are going with
this. If we find a match, we set a
variable named “GoOn” to true.
This allows us to know what we
should do after we’ve fallen
through the various If lines.
So, next page (top right) is the
code for the GetSeasonEpisode
routine.
8

When we get to this point,
(next page, bottom left) we
prepare the show name by
removing any periods in the show
name, and then pull the season
and episode information from the
various groups, and return them.
For the season information, if we
have a pattern like “S00E00”, the
season number will have a leading
zero. However if the pattern is like
“xxx”, then the season is assumed
to be the first character, and the
trailing two are the episode. In
order to be forward thinking, we
want to make the season a twodigit number with a leading zero if
needed.
Next, in our MakeDatabase
routine, we will change the create
contents ^
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SQL statement to add the two new
fields (next page, top).
Again, the only thing that has
changed from last time is the last
two field definitions.
In our WalkThePath routine, the
only changes are the lines that
actually insert into the database.
This is to support the new
structure. If you remember from
last time, we pass the folder that
holds our TV files to this routine. In
my case, there are two folders, so
it's set into a list and we use a for
loop to pass each into the routine.
As we go through the routine, we
walk through each directory
looking for files with extensions of
.avi, .mkv, .mp4 and .m4v. When we
find a file that matches, we send it
to the GetSeasonEpisode routine.
We then check to see if we already

def GetSeasonEpisode(filename):
GoOn = False
filename = filename.upper()

This is our first pattern check.

#Should catch multi episode .S01E01.S01E02 type filenames
resp = re.search(r'(.*)\.s(\d{1,2})e(\d{1,2})\.s(\d{1,2})e(\d{1,2})',filename, re.I)
if resp:
showname = resp.group(1)
GoOn = True
else:

Our second pattern check looks for SddEdd or sddedd...

# Should catch SddEdd or sddedd
resp = re.search(r'(.*).S(\d\d?)E(\d\d?)(\.*)', filename, re.I)
if resp:
showname = resp.group(1)
GoOn = True
else:

The next pattern looks for ddxdd.

#check for ddxdd
resp = re.search(r'(.*)\.(\d{1,2})x(\d{1,2})(.*)', filename, re.I)
if resp:
showname = resp.group(1)
GoOn = True
else:

This pattern checks for Sdddd.

if GoOn:
shownamelength = len(showname) + 1
showname = showname.replace("."," ")
season = resp.group(2)
if len(season) == 1:
season = "0" + season
episode = resp.group(3)
ret = [showname,season,episode]
return True,ret
else:
ret = ["",-1,-1]
return False,ret

#check for Sdddd
resp = re.search(r'(.*).S(\d\d)(.\d\d?)' , filename, re.I)
if resp:
showname = resp.group(1)
GoOn = True
else:

And finally we try for ddd

# Should catch xxx
resp = re.search(r'(.*)(\d)(.\d\d?)',filename,re.I)
if resp:
showname = resp.group(1)
GoOn = True

full circle magazine #72
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def MakeDataBase():
# IF the table does not exist, this will create the table.
# Otherwise, this will be ignored due to the 'IF NOT EXISTS' clause
sql = 'CREATE TABLE IF NOT EXISTS TvShows (pkID INTEGER PRIMARY KEY, Series TEXT, RootPath TEXT, Filename TEXT,
Season TEXT, Episode TEXT, tvrageid TEXT,status TEXT);'
cursor.execute(sql)

have it entered into the database,
and, if not, we add it. I’m going to
give you (top right) only part of the
routine from last month.
The two lines in black are the
ones that are new this time.
We are already over halfway
done. Next are some support
routines that work with our
TvRage routine to fill in the
database fields. Our first routine
runs after the WalkThePath
routine, and runs through the
database, getting the series name
and querying the TvRage server for
the id number. Once we have that,
we update the database, then use
that id number to once again query
TvRage to get the current status of
the series. This status can be "New
Series", "Returning Series",
"Canceled", "Ended" and "On
Haitus". The reason we want this
information is that, when we go to
check for new episodes, we don't
want to bother with series that
won't have any new episodes

"%s";' % fl

sqlquery = 'SELECT count(pkid) as rowcount from TvShows where Filename =
try:
for x in cursor.execute(sqlquery):
rcntr = x[0]
if rcntr == 0: # It's not there, so add it
try:
sql = 'INSERT INTO TvShows
(Series,RootPath,Filename,Season,Episode,tvrageid) VALUES (?,?,?,?,?,?)'
cursor.execute(sql,(showname,root,fl,season,episode,-1))
except:

def WalkTheDatabase():
tr = TvRage()
SeriesCursor = connection.cursor()
sqlstring = "SELECT DISTINCT series FROM TvShows WHERE tvrageid = -1"

because they are cancelled. So,
now we have the status and can
write that to the database (above).
We will pause here in our code
and look at the SQL query we are
using. It’s a bit different from
anything we’ve done before. The
string is:
SELECT DISTINCT series FROM
TvShows WHERE tvrageid = -1

instance of the series name, no
matter how many of them I have,
where the field tvrageid is equal to
“-1”. If, for example, we have 103
episodes of Doctor Who 2005. By
using the Distinct, I will get back
only one record, assuming that we
haven’t gotten a TvRageID yet.
for x in
SeriesCursor.execute(sqlstrin
g):
seriesname = x[0]

Which says, give me just one
full circle magazine #72

searchname =
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string.capwords(x[0]," ")

We are using the capwords
routine from the string library to
change the series name (x[0]) to a
“proper case” from the alluppercase we currently store the
show name in. We do this because
TvRage expects something other
that all-uppercase entries, and we
won’t get the results we are
looking for. So the series name
“THE MAN FROM UNCLE” will be
converted to “The Man From
contents ^
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def UpdateDatabase(seriesname,id):
idcursor = connection.cursor()
sqlstring = 'UPDATE tvshows SET tvrageid = ' + id + ' WHERE series = "' + seriesname + '"'
try:
idcursor.execute(sqlstring)
except:
print "error"
def GetShowStatus(seriesname,id):
tr = TvRage()
idcursor = connection.cursor()
dict = tr.GetShowInfo(id)
status = dict['Status']
sqlstring = 'UPDATE tvshows SET status = "' + status + '" WHERE series = "' + seriesname + '"'
try:
idcursor.execute(sqlstring)
except:
print "Error"

Uncle”. We use that in the call to
our TvRage Library FindIdByName.
This gets the list of matching
shows, and displays them for us to
pick the best one. Once we pick
one, we update the database with
the id number and then call the
GetShowStatus routine to get the
current show status from TvRage
(bottom right).
The UpdateDatabase routine
(top) simply uses the series name
as the key to update all the records
with the proper TvRage ID.
GetShowStatus (above) is also
very simple. We call the
GetShowInfo routine from the
TvRage library by passing the id

that we just got to TvRage – to get
the series information. If you
remember, there is a lot of
information provided about the
series from TvRage, but all we are
concerned about at this point is
the show status. Since everything
is returned in a dictionary, we just
look for the [‘Status’] key. Once we
have it, we update the database
with that and move on.

print("Requesting information on " + searchname)
sl = tr.FindIdByName(searchname)
which = tr.DisplayShowResult(sl)
if which == 0:
print("Nothing found for %s" % seriesname)
else:
option = int(which)-1
id = sl[option]['ID']
UpdateDatabase(seriesname,id)
GetShowStatus(seriesname,id)

We are almost done with our
code. We finally add one line to our
main routine from last month (in

black, below) to call the
“WalkTheDatabase” routine after
we are done getting all our

startfolder = ["/extramedia/tv_files","/media/freeagnt/tv_files_2"]
#for cntr in range(0,2):
#WalkThePath(startfolder[cntr])
WalkTheDatabase()
# Close the cursor and the database
cursor.close()
connection.close()
print("Finished")

full circle magazine #72
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filenames. Again, I’m going to give
you only part of the Main routine,
just so you can find the correct
place to put the new line.
That’s all our code. Let’s
mentally go over what happens
when we run the program.
First, we create the database if
it doesn’t exist.
Next, we walk through the
predefined paths, looking for files
that have any one of the following
extensions:
.AVI, .MKV, .M4V, .MP4

When we find one, we go
through and try to parse the
filename looking for a series name,
Season number, and episode
number. We take that information
and put it into a database, if it
does not already exist there.
Once we are through looking
for files, we query the database
looking for series names that don’t
have a TvRage ID associated with
them. We then will query the
TvRage API and ask for matching
files to gather that ID. Each series
will go through that step once. The
following screenshot shows the

options for, in this case, the tv
series Midsomer Murders.
I entered (in this case) 1, which
associates that series with the
TvRage ID 4466. That’s entered
into the database, and we then use
that ID to request the current
status for the series, again from
TvRage. In this case, we got back
“Returning Series”. This is then
entered into the database and we
move on.
While doing the initial “run”
into the database, it will take a
while and require your attention,
because each and every series
needs to ask about the ID number
match. The good news is that this
has to be done only once. If you
are “somewhat normal”, you won’t
have that many to deal with. I had
157 different series to do, so it
took a little while. Since I was
careful when I set up my filenames
(checking TvRage and
TheTvDB.com for the proper
wording of the series name), the
majority of the searches were the
#1 option.

Requesting information on Midsomer Murders
5 Found
-----------------------1 - Midsomer Murders - 4466
2 - Motives and Murders - 31373
3 - See No Evil: The Moors Murders - 11199
4 - The Atlanta Child Murders - 26402
5 - Motives & Murders: Cracking the Case - 33322
Enter Selection or 0 to exit ->

the age group I fall in.
The full code is, as always,
available on PasteBin at
http://pastebin.com/MeuGyKpX
Next time we will continue with
the integration with TvRage. Until
then have a great month!

Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

Just to let you know, over half
of the TV series that I have either
ended or have been canceled. That
should tell you something about
full circle magazine #72
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LibreOffice Pt25: Formula Layout

Written by Elmer Perry

A

s you create more complex
formulas in Math, you will
soon discover that things don't
always display the way you were
expecting. There are a few tricks to
making formulas display the way
we want them, especially complex
formulas. Today, we will look at
many of these tricks to make our
formulas come out right.

GROUP ELEMENTS WITH
BRACKETS
The curly brackets, {}, have a
special use in formulas. They help
you to group elements together.
Without them you can get a
different formula than the one you
were expecting. Here are a couple
of examples to show you what I
mean.
Enter the following into the
formula editor:
2 over x + 1

You will get the
following result:
But what if you actually wanted

the x + 1 in the denominator of the
fraction? You can use curly
brackets to group the two
elements together.
Enter the same formula in the
editor, but with curly brackets
grouping the addition:
2 over {x + 1}

You then get the
result you wanted:
Any time the formula doesn't
flow the way you were expecting,
you can use curly brackets to group
items together to make things
come out right. You will see more
use of brackets as we work
through other examples in this
How-To.

line would make the formula
difficult to read. However, just
pressing the Enter key in the editor
does not result in a new line. In
order to get a new line in the
formula, you use the newline
element.
Editor example:
x over 250 = 5 over 100
newline
100x = 250(5) newline
100x = 1250 newline
100x over 100 = 1250 over
100 newline
x = 12.5

Result:
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sum from x=0 to x=n f(n) "
or "
int from x to n f(n+1)

Result:

SCALED BRACKETS
Sometimes, you need a bracket
to span more than one line. A good
example of this is with a matrix. If
you just use the bracket
characters, you get an ugly looking
matrix.
The markup:
(matrix {x#x+1##y#y+1})

EQUATIONS SPANNING
MORE THAN ONE LINE
Some equations make more
sense if they are broken into
multiple lines, or you need to show
the progression of a formula
through each step to its
conclusion. Doing this all on one

The keywords ‘from’ and ‘to’
generate the lower and upper
range of these commands. The
following markup demonstrates:

The result:

SUM / INTEGRAL LIMITS
The sum and int commands can
take optional parameters to signify
the range of the sum or integral.
13

To get brackets that scale to the
size of our matrix we use the
markup “left (“ and “right )”. This
results in a much nicer looking
matrix.
contents ^

HOWTO - LIBREOFFICE Pt25
The markup:
left(matrix {x#x+1##y#y+1}
right)

L_{n-1} + L_{n-2} # if n >
1.}
right none

The result:

The result:
To get scalable square brackets
use “left [“ and “right ]”. To get
scalable curly brackets use “left
lbrace” and “right rbrace”. You can
find a full list of all the brackets in
the LibreOffice help
documentation.

UNPAIRED BRACKETS
Sometimes, you only need a
bracket on one side, but not the
other. If you don't put a closing
bracket, you get an inverted
question mark and the equation
will look messy. To fix this
problem, use the mark up “left
none” or “right none”, depending
on your needs, to indicate you have
no opening or closing bracket.
A good example of this is the
mathematical definition of the
Lucas Numbers.
The markup:
L_n = left lbrace
matrix{2 # if n = 0; ##
1 # if n = 1; ##

Notice that I ended the
definition with “right none” to get
our definition to show correctly.

ALIGNING ELEMENTS USING
MATRIX
You will notice (in the Lucas
numbers definition) I used a matrix
to get everything to line up
correctly. The matrix command is
useful for this because Math
doesn't have a command for
aligning on a certain element. With
the matrix command, we can use
the columns and rows to get
elements to align the way we want
them. A good example of this is to
get equations to align on the
equals sign.
For example:
matrix {
3x + 2x # `=` # 45 ##

full circle magazine #72

alignr 6x # `=` # 45
}

The result:
You will notice the back tick or
grave ( ` ) marks around the equals
signs. This is necessary because
the equals sign is a binary operator
and requires an expression on both
sides. The back tick ( ` ) is the small
space mark in Math. You could
accomplish the same thing with
the Math symbol for a long space
(~) or empty brackets ({}).
Remember in a matrix that
everything between the hashes is
an independent expression.
You will also notice, in the
second row, I use the command
“alignr” to align the 6x to the right
in its column. Use “alignl” to align
to the left and “alignc” to align to
the center. Center alignment is the
default, except in a matrix, which
defaults to left alignment.

c^2 = a^2 + b^2 newline
"The Pythagorean Theorem."

Result:

CHEMICAL FORMULAS
Math was designed for
mathematical equations, but you
can make chemical formulas, too.
Since variables are usually in italics,
you will want to turn off the italics
for variables (explained later).
Example:
matrix {
"molecules" # H_2 SO_4 ##
"Isotopes" # U lsub 92 lsup
238 ##
"Ions" # SO_4^{2-{}}
}

Result:

TEXT IN A FORMULA
Sometimes, you will need to
add notes or text to your formula.
You can add text by enclosing the
text in quotation marks (“”).
Example:
14

Note the “lsub” and “lsup” in
the isotope formula. The “lsub”
makes a left subscript, and the
“lsup” makes a left superscript. You
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will also need to add some special
CHANGING THE FONT AND
double arrows to your catalog for
FONT SIZE
chemical formulas.
COLOR, BOLD, AND ITALICS
The color, bold, and ital
commands allow you to emphasize
certain parts of your formula. They
affect only the elements which
follow them. To affect more
elements you need to group them
together with brackets.
Example:

Sometimes, you will want to use
a font or font size other than the
defaults. Format > Fonts brings up
the dialog to change the fonts for
variables, functions, numbers, and
text. You can also set some custom
fonts here as well. Format > Font
Size brings up the dialog for font
sizes. You set the base font, and
then the element sizes are set as
percentages of the base.

bold color blue c^2 = color
red {a^2 + b^2} newline
ital color green "The
Pythagorean Theorem"

Result:

dialog. In the Category dropdown,
you select the type of element
spacing you want to control. You
set the different spacing for the
elements as percentages of the
elements width or height,
depending on the spacing type.

For example, if we wanted to
change the spacing for the
alignment on the equals signs we
did earlier, we would select matrix
from the category. If we set the
column spacing to 0%, the
expressions will butt up against
the equals sign.

CONCLUSION
All the different options for
formatting your formula can seem
overwhelming, but you will get the
hang of it with practice. The first
and most important thing to
remember is using curly brackets
to group elements in a formula.
Look in the Elements dialog or the
context menu when in doubt about
how to do something, and you
might want to keep this article on
hand as a reference.
Next month, we will discuss
using formulas in LibreOffice
Writer.

Result:

Notice that I put brackets
around the elements in the square
root to make them red. Also, for
the c2, I combined color with the
bold command. You can choose
from eight colors: black, white,
cyan, magenta, red, blue, green,
and yellow.

CHANGING ELEMENT
SPACING AND ALIGNMENT

Format > Alignment brings up
the alignment dialog. Here we can
change the default alignment for
the formula, left, right, or center.
Elmer Perry's history of working,
and programming, computers
involves an Apple IIE, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.

Sometimes, it is necessary to
change the spacing and alignment
of the overall formula. Format >
Spacing bring up the spacing
full circle magazine #72
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Network Settings

Written by Jan Mussche

W

hen you connect your
desktop, laptop,
printer/scanner, tablet, cellphone
or whatever other device you
might have, to a network, you need
to set a few things straight in
order to get connected.
The first choice you make is
whether you use a wired or a
wireless connection. For the tablet
and the cellphone, this choice is
easy: only a wireless connection is
possible.
For the laptop and printer you
can, almost always, choose
between the two, and for desktops
the choice is probably made
already, with the presence of the
Ethernet port and the missing
wireless card.
The second choice is how do
you want your device to be
connect to your network. Do you
use the devices (cellphone, tablet,
laptop) also on other networks,
wifi at the office, school, mall or
maybe even in the train, or is it
(desktop, printer/scanner)
connected to only your own

private network? When using other
networks as well, the choice, if
there is even a choice, is simple:
you will use DHCP to set all
parameters automatically for a
working connection.

address” settings. This way, you
are in control: you decide which
address the computer uses, and
you know it always uses that one
same address.

What do you have to do to
setup a connection?

DHCP stands for: Dynamic Host
Configuration Protocol (See
http://en.wikipedia.org/wiki/Dyna
mic_Host_Configuration_Protocol
for more info about DHCP). Here a
DHCP server handles all requests
for a connection, it hands out the
IP address, sets the gateway, and
takes care of the correct DNS
addresses.

I will explain this using a
Kubuntu system. For other
systems, there will be differences
in setting it up, but they will be
minor.

Routers have a DHCP server on
board so you can use it very easily.
Using DHCP, the router will give
your connected device the first
free address in the range of
addresses it can use, meaning it
might use a different address each
time it is connected.
For a desktop, which is placed
under or on your table and which
will be there till it falls apart, you
can also use the manual “fixed
full circle magazine #72

When using a fixed address, you
always know which address it is
and you can use this in scripts to
address the computer.

Both ways have advantages.
When using DHCP, your device
will almost automatically be
connected to a network when it
comes in range AND you have
permission to connect to it. You
just need to chose the security
used by the network (if any) and
probably type in a password.

When you open the Network
connection settings, you see what
is shown in the picture above. I use
a wired connection, since this is the
only connection the computer has.
The connection is called: “Wired
connection 1”. Now this is just a
name, you can use anything you
want here. You can make more
than one connection if you need
to, each using its own settings.
Each time the computer is
booted, the connection is switched
on automatically—which makes
life easy.
As you can see, I use the
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Automatic (DHCP) method of
connecting to my router. In the
middle of the screen I chose DHCP,
and now the other fields for
setting IP address, Subnet mask
and Gateway are grayed out. They
don't need to be filled out since
the DHCP router takes care of
them.
In the second picture, I chose
the manual settings and typed the
values of IP address, Subnet Mask
and Gateway.

• The subnet mask is used to
organize your network. It tells
which addresses can be used by
means of a filter. In my case the
value is set to 255.255.255.0. This
means when placing this filter on
top of the address, the DHCP
server can use only the addresses
192.168.1.0 until 192.168.1.255.
Only the part after the last decimal
point can change. This is caused by
the value “0” in the mask. Mind
you, in this range there are a few
addresses which will not be used
for connected devices since they
are used by the network itself.

when you want to connect to it. It
is not important which address you
get, it is not important to know
which addresses the network uses.
Local networks can use one of a
couple of address ranges, either
the 192.168.x.x series or the
10.10.x.x series. Your device
receives an IP address and that's it:
you're connected. It is not
important to know which address
it is, what the gateway is—it all
works automatically.
But what if you want to have
the ease of use of the DHCP server,

and still want a fixed address so
you can use that address in scripts
when connecting to that device?
There is a way, but it depends
on your router whether it is
possible to use it.
Some routers can be told that
when device X is trying to connect,
it always gets the same address, no
matter how few or how many
devices are connected to the
router already.
This is done by means of the

• The Gateway is the door which
connects your local private
network to the Internet. It is the
address for the “inside” part of the
router, the local LAN side of the
router.
On the other side, the WAN side
of the router, the address is the IP
address your Internet Service
Provider gave you, either by means
of a fixed or a DHCP address.
A few explanations:
• IP address is the address your
device gets. It is like your home
address. In a network it is used to
find the device.

Using DHCP (on a private
network) has the big advantage
that you don't need to know
anything about the network, or
about somebody else's network,
full circle magazine #72
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MAC address. MAC stands for
Media Access Control. See
http://en.wikipedia.org/wiki/MAC_
address for more info.
The MAC address is a unique
address for each network
card/chip, and is stored in the read
only memory of the card, or in the
chip which handles network traffic.
There are no two chips/cards in
the world with the same MAC
address. This makes them unique.
(However, on most network
hardware, you can spoof a MAC
address, tell it to use an address
you specify, not what is on the
chip.)

a different IP address from my ISP.
Since we are connected 24/7 it will
not happen frequently.
Below that you see the local
network setup.
The router has the address
192.168.1.1, with a subnet mask of
255.255.255.0, meaning addresses
192.168.1.1 – 192.168.1.255 can be
used.
DHCP Server is enabled,
because I want to make it easy for
devices to connect to the network.
DHCP is using the addresses
192.168.1.100 – 192.168.1.199 (100
addresses, this should be enough

for my wife and me).
In this section of the setup, you
find the button DHCP Reservation.
This is the one to use if you want to
combine DHCP with fixed
addresses.

When clicking the button you
will see the next picture, which is a
part of the total screen which
shows up.
In here you see a table with
connected devices, their assigned
IP address, their MAC addresses
and buttons to remove them from
the list.

Give your device a name which
is easy to remember, choose an IP
address, find the MAC address the
device uses, and add it here on this
page. (This is done in another part
of the page, which is not shown
here.) Save your settings.
Reboot your device and check
the IP address it received. It should
match the entry in the table.
Now you have the best of both
worlds, and the ease of using a
DHCP server, and the fact your
devices always use the same fixed
IP addresses.

Now, how to use the MAC
address? This depends on your
router, if it is possible, and, if so,
how to do that.
My router, a Cisco Linksys
E4200, has the ability of combining
the MAC address of a connected
device to a handed-out IP address.
In the Setup tab you find the
settings for your Internet
connection. As can be seen here, I
have a DHCP address from my
provider. This means, whenever
the modem shuts down, I could get
full circle magazine #72
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Blender - Part 5

Written by Nicholas Kopakakis

H

aving a lousy model is not
something that you want for
your models, of course, but, as a
good friend of mine (and
experienced 3D artist) told me:
“you can save a lousy model with
good texturing.”

I will give you an example to
make it more clear what textures
are and what they are capable of.
In the image below, we have a
sphere with a plane, and
illuminated by 3 lights.
And, finally, we have ball of
aluminum foil garbage on a beach
(very sad).

This month, I will try to explain
the very basics of texturing (the
truth is that I know the very
basics). There are a lot of books
out there describing texturing
techniques—as textures are a very
important matter for 3D modeling.
Low poly is a polygon mesh in
3D computer graphics that has a
relatively small number of
polygons. We usually use low poly
models for performance reasons,
in real-time applications such as
games.
High poly models are usually
used for animated movies or high
detail pictures, in conditions, in
general, where we don't have realtime performance restrictions.
(http://en.wikipedia.org/wiki/Low_
poly)

tab.

Next, we have the same
objects, but this time with textures
and image mapping to create the
surface filling on earth.

For the last picture I used an
image for the sand, and, for the
foil, the cloud texture with some
normal map displacement.
But enough with the examples.
Let’s load our snowman.blend file.

Next, we have the same objects
with different textures on them.
full circle magazine #72

Now, go to the material tab and
press the New button to create a
material for the body of our
snowman.

Name the material with a
unique name—for example,
“body_Material”.
Next, press the tab next to the
material tab called Textures.

Select the three spheres (body)
of our snowman, and press Ctrl+J
to Join the three meshes to one.
Name it “body” under the object
19
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with these settings:

Press New to create a new
texture. Name it body_Texture, or
whatever you like.
Find a picture of snow to use as
a texture. There is a very
interesting site that I use a lot at
http://www.cgtextures.com. You
can register and have access to
thousands of images that you can
use as a texture (with the free
registration you can download up
to 15MB of images per month.
Download the low resolution
images and you will be just fine).
For our snowman, I downloaded
the image Snow0041_5_S.jpg.
Under the type button, select
image or movie.

Then press Open under the
Image section, and navigate to
your file system to select your
image.

Under the Mapping section,
select Sphere for the Projection
and leave Coordinates as it is
(Generated).

Under the Influence section,
tick on Emit and put the value
-0.800 to light up your image a
little, and, under Geometry, tick
Normal and enter 4 for value to
give a hard surface feeling.

Finish the snowman by creating
and applying textures to the rest
of the meshes (hands, nose,
mouth, etc.)
Feel free to send me your
creations of the snowman project
at blender5d@gmail.com, and I'll
present the best here at Full Circle
Magazine.

Leave the rest to default, or
experiment with them to see what
you get (remember that
experimenting is one of the three
things that you need to master
blender, the other two are
practice!).

Next month, I'll introduce you
to the Cycles render engine—a
very powerful renderer that has
been included with the blender
distribution ever since version
2.64. Also, we will start a new
project. Send me your ideas.

Now, for the ground, here’s
what I have done (of course, you
can use an image instead). I
created a texture from the type
Clouds, adjusting some of the
settings.

For this month, I have a game
called Dead Cyborg created by
Endre Barath
(http://www.deadcyborg.com).
Another game created with the
blender game engine. Enjoy!

full circle magazine #72
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Nicholas lives and works in Greece.
He has worked for a post-production
house for several years and migrated
to Ubuntu because “it renders
faster.” You can email him at:
blender5d@gmail.com
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Inkscape - Part 12

Written by Mark Crutch

C

reating images, diagrams and
drawings in Inkscape is all very
well, but, at some point, you are
likely to need them in a format
other than Inkscape's own
variation of SVG. Inkscape has
many import and export formats,
with the exact selection depending
on various external applications as
well. In this article I will introduce
the most common and most useful
formats, generally found in the file
format popup of the File > Save
As... dialog. Let's start with a very
common file type amongst
Inkscape users: SVG.
You may not have given much
thought to SVG as an export
format, other than knowing that
it's Inkscape's default file type. Yet
Inkscape actually offers six
variations of SVG in its Save As...
dialog, each making different
trade-offs between file size and
content. The first, simply referred
to as “Inkscape SVG”, is the
standard Inkscape format, and is
the one you should probably use to
store the master copies of your
Inkscape drawings. It preserves all
the Inkscape-specific data, which is

great for use as a master format,
but does mean that the file size is
large, and it's saving a lot of
information that most other
applications won't understand.
If the size of the file is your
main concern, but you still want to
preserve the Inkscape-specific
data, then you should use
“Compressed Inkscape SVG”. This
has an svgz file extension, and is
the same as a standard Inkscape
SVG file, but compressed using the
Gzip algorithm. This can typically
reduce the file size by fifty percent
or more. Compressed files are
more prone to data loss if the file
becomes corrupted, and
sometimes won't display in
applications that are otherwise
happy to render SVG files. Some
web browsers won't render them
when loaded as local files, despite
being happy to accept them when
issued from a web server.
Most other applications won't
understand the Inkscape-specific
data in an SVG file, so you can also
save a version with this stripped
out. This is the “Plain SVG” option,
full circle magazine #72

and its Gzipped counterpart,
“Compressed Plain SVG”. These
will save you a few bytes and
produce a purer version of the SVG
that can be easier to work with if
you subsequently have to edit the
file by hand, or if you want to use it
on a site like Wikipedia—where
simple SVG files are favoured over
application-specific versions.
Although this might appear to be
an ideal format for serving on the
web, it does remove <script>
elements, which limits its appeal
for some web content.
If you really want to remove
every redundant byte from your
files, then the “Optimised SVG”
option (below right) is the one to
go for. This runs the output
through a Python script called
“scour” which is also available as a
stand-alone application. It
presents a dialog to let you finetune the optimisations it will
perform, and can take a while to
run if the file is complex.
Getting the best out of Scour
relies on some knowledge about
the structure of SVG files. There's
21
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no compressed version of the
“Optimised SVG” format available
from within Inkscape's save dialog,
but you can manually Gzip the
resultant SVG file for the same
effect.
The final SVG format is
“Compressed Inkscape SVG with
media”. This actually creates a zip
file (not Gzip) which contains an
Inkscape SVG file, plus copies of
any linked media. The linked media
are typically bitmap images that
have been added to a drawing, but
not embedded. Adding bitmap
graphics is a subject we'll be
covering later in this series. This
format is useful for transferring an
Inkscape drawing, and all its linked
media, to another machine, but,
ironically, it can't be opened by a
copy of Inkscape on the receiving
end. Instead, the zip file has to be
decompressed, and only then can
the included SVG file be opened.
As a comparison between the
sizes of these SVG variants, I saved
a copy of the snowman drawing
from part nine of this series in
each format. I also did the same
for one of my longer comic strips.
The “Compressed Optimised SVG”
was manually compressed using
“gzip -9 filename.svg” to give the

Format
Inkscape SVG
Plain SVG
Optimised SVG
Compressed Inkscape SVG
Compressed plain SVG
Compressed Optimised SVG
PNG exported at 90dpi

best compression, and the
filename extension then changed
from “svg.gz” to “svgz”. Finally I
also exported both files to PNG
format to show the difference
(shown above) in size between
bitmap and vector graphics.
As you can see, the differences
become more significant as the
complexity and size of the image
increase; however, we're still
talking about relatively small
savings in these days of multiterabyte hard drives. Saving plain,
optimised or compressed files is
generally only worth doing if you
have a specific reason or
requirement – such as wanting to
hand edit the files, or use them on
a site like Wikipedia. If you've got
plenty of space on your web server,
it's not even worth compressing
your files for online use: instead
ensure that your web server
software is configured to gzip the
data on the fly. In my own case, I
full circle magazine #72

Snowman
172KB
154KB
133KB
93KB
90KB
87KB
211KB

Comic
849KB
769KB
504KB
274KB
261KB
209KB
1400KB

use compressed Inkscape format
for the files that can be
downloaded from my website –
with over 200 comics available to
download, it helps keep storage
costs down – but I use the
uncompressed Inkscape format
when storing files locally.
After SVG, the most common
export format is probably PNG.
This is a bitmap format that can be
viewed by almost all web browsers
and graphics programs. It's the
only standard bitmap format that
Inkscape can export to, so if you
want to convert your image to a
JPEG, TIFF, Windows BMP file or
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any other type of bitmap graphic
your first step will be to create a
PNG and then convert it in another
application.
A very common—and
understandable—mistake that new
Inkscape users make is to use the
“Cairo PNG” option from the File >
Save As... dialog. Unfortunately,
this is almost never the right way
to create PNGs, as it doesn't
support transparency or filters.
Instead you should use the File >
Export Bitmap... menu entry, which
will open the PNG export dialog.
The four buttons at the top of
the dialog are handy shortcuts for
choosing what part of your image
you would like to export: the whole
page, a rectangle large enough to
enclose the whole drawing – which
could be larger or smaller than the
page, a rectangle large enough to
enclose all the objects you
currently have selected, or a
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custom rectangle whose size is set
by the x0, x1, y0 and y1
coordinates. You can also specify a
custom rectangle using x0, y0,
Width and Height, in which case
the x1 and y1 figures will be
updated automatically.
Usually everything that's visible
on screen and which lies within the
specified rectangle is exported. If
you want only the selected object
or group exported, without any
background elements, you can
check the “Hide all except
selected” box at the bottom of the
dialog. If you have more than one
object or group selected, you can
use the “Batch export” checkbox
to save each of them to a separate
file.
The “Bitmap Size” part of the
dialog allows you to set the Width
and Height of the PNG file that will
be created. Alternatively, you can
set the “dots per inch” or “dpi”,
which will also change the Width
and Height fields. Increasing the
dpi will produce a file that is larger,
with more pixels; reducing the dpi
will result in a smaller file with
fewer pixels. 90dpi is usually good
for web graphics, but you might
want to use 300dpi for a file that is
going to be printed. If you want it

printed twice as large, use 600dpi
instead, or 150dpi for half the size.
The rule here is the same as with a
digital camera: more pixels equals
more detail, but a bigger file size.
The last part of this dialog, the
“Filename” section, is a little
deceptive. You can type a path and
name, although whatever name
you use, Inkscape will always
produce a PNG file. Alternatively,
you can click on the “Browse...”
button to bring up a file selector.
The catch with this is that the file
selector has a “Save” button which
doesn't actually save the file.
Instead it simply puts the selected
path and filename into the
“Filename” field, but the image
isn't actually created on disk until
you click the “Export” button.
Exporting is usually quite fast, but
can take a while for large dpi
values, or if the image contains
complex filters.
Moving back to the “Save As...”
file selector, the “Portable
Document Format”, “Postscript”
and “Encapsulated Postscript”
options are all variations on a
theme. These are most useful
when creating files for a print
bureau, as they often expect to
receive these “industry standard”
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formats. They all present a very
similar looking dialog in which to
set a few options.

The most important options are
“Convert texts to paths” and
“Rasterise filter effects”. The
former will automatically convert
your text objects into paths within
the exported file, which prevents
problems caused by using fonts on
your machine that aren't present
on the target machine. None of
these formats support the filter
effects – including the simple blur
– that SVG offers, so if you don't
choose to “rasterise” these, the
corresponding objects will simply
be omitted from the file.
Rasterising consists of creating a
bitmap version of the filtered
content, so, much like the Export
Bitmap dialog, there's a setting for
the dpi. Once again a high value in
here will produce more detail in
the output file. If you're creating a
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PDF to view on a computer screen,
then 90dpi may be sufficient, but,
if you want a high quality print, or
you expect your readers to zoom
in, you should probably set this
higher.
An alternative way to create a
PDF for a print bureau is to import
your SVG file into Scribus and use
that to generate the PDF file.
Unfortunately, Scribus doesn't
support all of Inkscape's SVG
features, so this approach may not
work for more complex drawings.
My experience has been that it's
often easiest to simply export a
high resolution PNG file and let the
print bureau deal with getting it
into a suitable format for their
systems. The downside of this
approach, other than the large file
you'll need to create, is that your
vectors are rasterized prematurely,
so you probably won't get the
smoothest possible output. For
small items, that may not matter,
but, if your plan is to create
posters or billboards, it can make
all the difference. Inkscape's PNG
files are all in RGB format, and
some particularly fussy bureaus
may complain that they want
CMYK files. Even if they're happy
to work with PNG files, do make
sure you get a proof from them
contents ^
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first to check that the colors are
what you expect.
There are a variety of other
export formats available in the
Save As... file selector, serving
various niches. Each has its own
limitations on what Inkscape and
SVG features can be successfully
represented. For more details
about many of these formats read
the Exporting Files section of
Tavmjong Bah's excellent Inkscape
manual (link at the end of the
article). Given the target audience
of Full Circle Magazine, though,
there's one more format that
should be discussed: “GIMP XCF
maintaining layers”.

This export format is available
only if GIMP can be found in the
system path. For most Linux
systems, this will be done
automatically if you install the
application using your package
manager, or if it's installed as part
of the default installation. Once
it's available to you, selecting it
will present a dialog with a few
options for the export.

The “Save Guides” and “Save
Grid” options will include any
Inkscape guides, and the first
rectangular grid, as their GIMP
counterparts. We haven't talked
about guides and grids yet in this
series, but, if you've stumbled
across them on your own, these
options might be useful. In
practice, the guides may be useful,
but the grid will appear much
denser in The GIMP than in the
original Inkscape file, and can even
be so dense as to obscure the
image entirely! The “Save
Background” option is also a
problem as it applies the document
background color (set in File >
Document Properties... within
Inkscape) to every single layer,
rather than just creating a single
background layer. In practice,
therefore, I would suggest leaving
at least the latter two options
unchecked unless you have a
particular reason to do otherwise.
Loading the resultant XCF file
into The GIMP will produce exactly
what you expect – a bitmap
representation of your Inkscape
file with each of the Inkscape
layers present in a corresponding
GIMP layer... almost.
Unfortunately, any sub-layers are
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automatically rendered into the
parent layer, rather than remaining
as separate layers in The GIMP. If
you want to keep your sub-layers
separate, you'll need to promote
them to top-level layers before you
export the file. The images created
by this export option are fixed at
90dpi – if you want a different
sized image then you have to scale
the objects within Inkscape first.
An alternative to creating an
XCF file from Inkscape is to instead
load an SVG file directly into The
GIMP. This will not preserve any
layers, flattening the image down
to a single layer instead. Some
more advanced SVG features, or
Inkscape-specific additions, may
not render correctly. Loading an
SVG file into The GIMP does,
however, let you set the size of the
rendered bitmap

The “Import paths” option will
create a GIMP path for each object
in your SVG file. This can be useful
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if you wish to convert one or more
paths into a selection in order to
limit the scope of your GIMP edits.
Generally, it's worth checking this
box – you can simply ignore the
paths if you don't need them, but,
having them available can make
some editing tasks a lot easier. The
“Merge imported paths” option is
less useful. It creates a path for
each object in the SVG file, then
merges them all into a single path.
Given that you can combine
multiple paths into a single
selection within The GIMP, leaving
them separate still allows you to
create a single unified path if you
need to.

LINKS:
Scour: https://launchpad.net/scour
“Exporting Files” in the Inkscape
manual:
http://tavmjong.free.fr/INKSCAPE/
MANUAL/html/File-Export.html

Mark has been using Linux since
1994, and uses Inkscape to create
two webcomics, 'The Greys' and
'Monsters, Inked' which can both be
found at:
http://www.peppertop.com/
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Write For Full Circle Magazine

Written by Ronnie Tucker

GUIDELINES

document.

REVIEWS

T

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

GAMES/APPLICATIONS

he single rule for an article is
that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

• Do not use tables or any type of
bold or italic formatting.

RULES
• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!
• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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https://spideroak.com
Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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A S K T H E NE W G U Y

Written by Copil Yáňez

H

i, everyone! Welcome back to
Ask the New Guy!

If you have a simple question,
and want an answer that doesn’t
require you to know the difference
between Mir (the display server)
and Mir (the Russian space
station), contact me at
copil.yanez@gmail.com.
Today’s question is:
Q: I want to run Ubuntu on a
laptop but can’t afford one with
all the bells and whistles. Can you
recommend one?
A: Well, your first problem is that
you’re looking for a laptop with
bells and whistles. What are you, a
steampunk accountant? The only
people selling laptops with bells
and whistles have names like
Mistress Infinity and live in the
wondrous City of Neverling, where
the Kittenmen pilot steampowered dirigibles in their fight
against The Omnicult. But if that’s
where you’re shopping for laptops,
remember it’s rude not to haggle.
AND DON’T BUY THE EXTENDED

WARRANTY!
For the rest of you, finding a
laptop that works with Ubuntu is
surprisingly easy. Ubuntu’s
minimum requirements were
determined during the Dark Ages,
when copy/paste meant asking a
Franciscan monk to cut up an
illuminated manuscript. Ubuntu
should run comfortably on
anything with a 1 GHz processor, 1
GB of RAM and around 8 GB of
hard drive space. Pretty sure your
toaster has that. If not, ask around.
Some of your friends probably
have computers more than four
years old with better specs than
the minimum. Currently, those
laptops are being used as hipster
coasters. Tell your friends you’ve
started a non-profit that turns old
computer equipment into braces
for crooked-toothed ocelots. In
very short order, you’ll have, like,
six almost-new Dells ready to be
resurrected.
If that isn’t an option (because
you don’t put quotes around the
word “ethics” like I do), you might
be tempted to ask one of your
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super-tech-savvy friends for help.
DON’T DO IT! Ubuntu seems to
bring out the weird in some
people. You’ll tell your friend you
need a laptop and ask for
suggestions. Your friend will then
tell you why you’re all wrong and
why laptops are on the way out.
The REAL action is in DIY small
form factor PCs with custom 3Dprinted enclosures and a roll-yourown distro that launches to a
terminal window on startup. Ugh.
If he or she starts talking about
embedding Ubuntu in a soda can or
a belt, run for your life. Your friend
belongs to a unique subset of
computer users known as BDSM
Geeks. These people are happy
only when their homegrown
systems make them miserable.
Still, BDSM Geeks are better than
BSD Geeks. OH, SNAP!

haven’t given you a decent
suggestion for your own laptop
needs.
Let’s remedy that.
There are plenty of laptops, in
just about every price range, that
will run Ubuntu comfortably, more
if you are open to getting
something used or refurbished.
The biggest determining factor, in
my opinion, is how you’ll use your
laptop. For most of us, we don’t
need a desktop replacement, we
just need something for web
browsing, email, chat, and the
occasional strongly worded letter
to the dry cleaner who keeps
ruining our shirts. The ideal
machine can run Ubuntu without

Let’s see, so far I’ve suggested
you acquire a laptop under false
pretenses, and then I invented a
sadist geek culture to make fun of
hard-core enthusiasts who are just
as happy running a different distro
ever hour, on the hour. I’m making
friends right and left but I still
27
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stuttering, has decent battery life,
and doesn’t require you to sell
plasma for the next year to make
payments.
Lots of laptops fit the bill but,
for my money, the most
interesting player right now is the
Google Chromebook.

exactly an impulse purchase, but it
doesn’t require a visit to a loan
officer, either.
What really makes this an
interesting purchase—one I
couldn’t pass up—is that you can
run Ubuntu on it.
Whaaaaaaaat?!

Huh? Isn’t that a Chrome OS
machine?
It is. But bear with me and you’ll
see why I think this is one of the
most interesting values out there.
Let’s look at the specs of the
Samsung Chromebook:
• 11.6’’ (1366x768) display
• 0.7 inches thin – 2.42 lbs / 1.1 kg
• Over 6.5 hours of battery
• Samsung Exynos 5 Dual Processor
• 100 GB Google Drive Cloud
Storage with 16GB Solid State
Drive
• Built-in dual band Wi-Fi 802.11
a/b/g/n
• VGA Camera
• 1 x USB 3.0, 1 x USB 2.0
• HDMI Port
• Bluetooth 3.0™ Compatible
All of this is kinda interesting
and inexpensive at $249. Not

Oh, yeah.
Here’s what I love about the
Linux community. When I started
looking for ways to run Ubuntu on
the Samsung Chromebook, I
couldn’t find one. I found TWO!
Both will give you stock Ubuntu
(with a few limitations), and allow
you to switch back over to the
installed ChromeOS whenever you
want.
It’s easy, it works and it turns a
$249 browser-based laptop into
something far more intriguing.
Purchasing the laptop was easy.
I used Amazon but you can go
through the Google Play Store or
even pick one up at Best Buy. I
never quite understood “unboxing
videos”, so I won’t provide one
here. It’s just too much like
stripping, and I feel weird about
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chanting “Take it off, take it ALL
OFF!” to a laptop. YMMV.
The design is sleek and light.
The chicklet keyboard feels a bit
thin but it is full-sized and
comfortable. The screen won’t win
any awards but I watched the
opening of Top Gun via Netflix, and
suddenly had the urge to play
beach volleyball. The browser is
fast and responsive, and opened all
my favorite web pages quickly. All
of this was on the Chrome OS,
which seems well suited to the
typical user needs I mentioned
above (email, browsing, word
processing).
But this is an Ubuntu magazine,
so let’s get Ubunting!
I mentioned there are two ways
to run Ubuntu. One is called
ChrUbuntu and the other is called
Crouton.
I chose ChrUbuntu because the
installed base seemed deeper.
More people means more places to
turn when I run into trouble. I’m
like the John Dillinger of Ubuntu
enthusiasts; I always need an exit
strategy. $249 isn’t a king’s
ransom, but, if I brick the machine,
I’ll have to explain to my wife why I
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bought a $249 hipster coaster
when we could have just borrowed
one from a friend.
I followed the instructions here:
http://chromeoscr48.blogspot.com/2012/10/armchrubuntu-1204-alpha-1-now.html
I read them through a couple
times before attempting the
install, and made sure I typed in
everything exactly as it appeared
on the page. Note that this works
with the Samsung Chromebook
and that there are different
instructions for the Acer model.
Basically, you put the
Chromebook into Developer Mode
and then run a script that loads the
modified Ubuntu distro onto either
the internal drive, a USB drive, or
an SD card.
It is no false modesty to say this
was drop dead simple. I followed
the instructions for loading
ChrUbuntu onto the internal SSD
drive, and everything ran as
advertised. All told, it took about
twenty minutes from discovering
ChrUbuntu to seeing the familiar
app ribbon along the left.
Here’s how Ubuntu 12.04 looks
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running on the Samsung
Chromebook. Sexy, right?

So how does it run?
If you’re hoping for a balls-tothe-wall overclocker’s wet dream,
you’re going to be sorely
disappointed. Actually, if your wet
dreams involve processors, you’re
probably already disappointed.
Just saying, this is a stripped down
laptop running a non-standard OS.
Expectation management is the
game here.
The two main things that don’t
work out of the box are sound and
Flash. There are fixes for both but
it does require some work at the
command line. Also, the trackpad
doesn’t work as smoothly as it
does on the Chrome OS side. After
a while, I knew to use the fleshy

pad of my finger (instead of the
fingertip) to move my cursor
around. I am hoping this gets fixed
soon but it didn’t keep me from
using the machine.
Another negative, there’s no
graphics acceleration. Videos run
fairly well in a smaller window, but
expanding them to full-screen
results in an unwatchable stutter.
This isn’t the machine you use if
you’re editing the new Star Wars
movie for Disney. Unless you
intend to have Jar-Jar in it, in which
case, this is TOTALLY the right
machine to edit that movie.
That said, the experience wasn’t
unpleasant, and using my new
ChrUbuntu install worked perfectly
well for surfing the web, sending
emails, and opening word
documents. That last bit was
accomplished by downloading
LibreOffice from the Ubuntu
Software Center. Not all programs
work with ChrUbuntu (Dropbox is
unavailable, for example), but I was
happy to see this one does.
Another plus is that the
Samsung uses a 16GB solid state
drive. You have to split that
between the two OSs, but once
you install ChrUbuntu, you have a
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silent Linux laptop with decent
battery life.
Probably the biggest downside
I’ve found so far is that switching
between OSs is a pain. You can’t
choose one or the other at startup,
you have to choose a default using
a (for me) non-intuitive terminal
command. The new OS starts on
reboot. This isn’t a big deal, but it
does keep you from jumping from
one to the other as needed.
This is probably the right time
to mention the other solution,
called Crouton. Crouton offers
something called a chroot
environment. Basically, you’re
running Ubuntu using the
underlying Chrome OS. The
technical details were lost on me,
but one reason I’m going to give it
a try soon is that switching
between OSs is a simple matter of
hitting CRTL-ALT-SHIFT-FORWARD.
The most promising aspect of
these solutions is that they’re in
their infancy. ChrUbuntu is stable
and much of it works out of the
box. Yes, the Samsung is optimized
to use the Chrome OS side. So
battery life and user experience
are going to be less than optimal
right now. But the community is
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already working on fixes for the
most common issues. It’s likely that
this is the worst it will ever be,
meaning, the future looks pretty
bright.
As a huge Ubuntu fan, I
sometimes get a little tired of
feeling like a computing hobo,
using hand-me-downs and
machines held together with
chewing gum. Even though one of
the benefits of using Ubuntu is
being able to run it on almost
anything, it’s nice to get a new
piece of kit every once in a while.
If you’ve been looking for a new
laptop, include the Google
Chromebooks in your search. They
might not be perfect for your
needs, but they work well enough
that they deserve to be in the mix.
Whatever you choose, good
luck and happy Ubuntuing!

Copil is an Aztec name that roughly
translates to “you need my heart for
what again?” His love of women’s
shoes is chronicled at
yaconfidential.blogspot.com. You
can also watch him embarrass
himself on Twitter (@copil).
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Sony’s Dash HID-C10/ TX

Written by Charles McColm

S

ony’s Dash HID-C10/TX is a
wifi-enabled touch-screen
Home Information Device (HID).
Our device came in as a donation
to our local computer reuse
project. We were excited because
we discovered the device was a
collaboration between Sony and
Chumby. In Issue #62, I wrote
about my effort to create a Twitter
screen based on a small device I’d
seen at our local hackerspace. That
device was an original Linux-based
Chumby.
Setup of the HID-C10 requires a
wireless network and a PC to
complete the
activation/registration process.
Initially when we attempted to set
up our HID-C10, the setup failed.
We looked up the code the HIDC10 gave – which suggested we
contact Sony. It was after-hours so
we put the device away. The next
day we booted the device and
setup continued without problems.
We were able to register our HIDC10 using one of our Linux
workstations, and the registration
seemed to take on the device, but,
when we went to add new apps,

we kept getting a Load failed,
unable to load catalog. As a result,
we weren’t able to add new
applications. Despite our device
registering, we believe the account
we set up didn’t get associated
correctly with our registration, and
subsequently we couldn’t add
apps.
We checked the Sony Dash web
site (link below) – where the HIDC10 is one of two Dashes featured
there – to see if there was a
solution. The site had several
suggestions ranging from
unplugging the device to doing a
normal restore, but none of the
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solutions helped us get the
applications catalog loaded. The
HID-C10 purportedly supported
Chumby applications, but, sadly,
Chumby itself went out of business
in December, 2011. Volunteers
maintained the Chumby site
through funding from a succession
of companies, but funding ceased
February, 2013. One volunteer
made an effort to acquire the
assets of Cumby in January, 2013,
with the intention of continuing
the service, but the short time left
in existing funding made it difficult
to continue maintaining the
service as it was before. This might
have been the reason applications
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weren’t working on our Dash,
except for a blurb on the web site
which indicated all service for the
Dash was now through Sony.
Sony appears to have kept
many of the Chumby applications
for the Dash alive. Some thirdparty developers still appeared to
be providing updates for their
applications until early 2013. That
said, a lot of the applications didn’t
seem to have the polish you’d
expect from the Ubuntu software
center, Android market, or other
app store. So what did work?
Pressing the left side of the
snooze button brings up a toolbar.
Clicking menu brings up a side
menu showing clock & weather,
Themes and Apps, Video, Music,
Photo, and System sub-menus. Of
the menu options, only the Apps
portion didn’t work. We were able
to change themes, play video
through Youtube, eHow, Wired’s
What’s Next in Tech (to name a few
of the sources), music through
Slacker Radio (wife loved the Latin
Salsa channel), but not Shoutcast
or blue octy radio (which we figure
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is due to Chumby being out of
service and the volunteer site at
half-mast). Photos can be
displayed from a USB flash drive or
through the Photobucket online
service.
Various reviews we looked at
slagged the HID-C10 as a glorified
alarm clock and knocked it for the
lack of applications. Compared to
most Android-driven cell phones
(even old ones running Android
2.3), the Dash’s application
collection is pretty small.
Thankfully, the alarm clock portion
actually did work. We were able to
set and store an alarm to wake us
on particular days at particular
times. We found the video
playback to be quite good. Better
quality videos show up crisply on
the HID-C10. We also found Slacker
radio streamed without any
interruptions. Once we changed
the theme of the HID-C10, it felt a
bit more useful because the theme
we started with concentrated on
apps rather than what was preinstalled.

on-screen menu. The top also
features a couple of volume
buttons. The Dash is powered by a
corded plug and doesn’t support
batteries, so, despite the wireless
radio inside, it’s not a completely
wireless device. We saw the device
more as a kitchen appliance for
playing music and video while
preparing food rather than a slick
hackable device.
The Dash features a
chronometer which is a bit odd
since the device isn’t really the
kind of thing you’d carry around,
and the shape isn’t conducive to
standing on its top or sides.
Perhaps the most tragic flaw of the

Dash is the fact that service for it is
available only in the United States
and Canada. Again, we thought
this was strange since the Dash is
suppose to be an Internetconnected device.
We didn’t get a chance to talk
to Sony before this review was
due, but that’s our next step. It
appears the Dash should be
working and that Sony is still
providing limited support for the
device. Sadly, they closed
developer support as of February
2013, which means third party
developers and open source
developers can no longer update
their apps for the Dash, effectively

rendering it obsolete. Despite this
apparent obsolescence, and the
trouble with maintaining Chumby,
the Chumby forums appear quite
active. As a reuse and refurbishing
project, we hope someone comes
along and supports the parent
volunteer Chumby revival project
to allow free software developers
to continue making these devices
useful.

USEFUL LINKS:
Sony’s Dash support site:
https://dash.dash.sel.sony.com/
Sony’s larger community forums:
http://community.sony.com/
Chumby Company Site:
http://www.chumby.com/
Chumby forums:
http://forum.chumby.com/
Chumby wiki:
http://wiki.blueocty.com/index.php
?title=Main_Page

Charles is a step-father, husband,
and Linux fan, who hosts a not-forprofit computer refurbishing
project. When not breaking
hardware/servers, he maintains a
blog at:
http://www.charlesmccolm.com/

The HID-C10 features a hidden
side output for headphones and a
side input for a USB flash drive.
The top has a large snooze button,
the left side of which brings up the
full circle magazine #72
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MY STORY
Written by Vince Du Beau

M

y first introduction to Unix
was in 1979. The company I
was working for at the time got
the PWB (Programmer's
Workbench) version to experiment
with. We needed this for its ability
to do remote job entry to the IBM
mainframe. I just loved the
simplicity of Unix on the surface,
but also loved the powerful beast
(maybe a grue?) lying beneath the
surface.
For the next 18 months we
learned about Unix and
programming in C. It was a great
time.
In late 1980, I got an offer from
another company for a much
better opportunity. I left the Unix
environment. I've always had some
regrets about leaving: from a
personal angle, leaving something
I enjoyed working with, and, on the
professional side, wondering what
paths my career would have taken.
(Would it have been worse or
better?)
Through the 1980's, I
considered Unix variants Coherent

and Xenix. The AT&T PC7300 would
have been my ideal choice but it
was around $5,500.00.
I eventually succumbed to the
corporate standards, and adopted
Microsoft Windows and office
products to maintain
compatibility.
In 1995,
while at a
local
computer
show, I
came
across a
fellow
selling
Slackware
Linux. I had
heard of Linux
from a friend
who still worked at
my original company. I
bought a copy and installed it on
an extra drive in my computer.
Unlike today’s Linux distros, once
installed, you had to go through a
series of screens to configure the
kernel for your hardware and other
options, and recompile the kernel.
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Even after using Windows for
years, I was having a great time.
The various window managers
at the time were rough. I settled
on FVWM (F Virtual Window
Manager). It worked fine, but you
had to edit a configuration
file to add any
applications to it.
I played with
various
distributions
over the years
as they came
out. I used
Red Hat,
Caldera, Corel,
etc. I
eventually
settled on SuSE,
and was using Linux
full-time, delving into
Windows when I needed to
for something with a client
company.
In 2002, I decided to jump to an
Apple iBook (no flames please). I
liked it, but still wasn't giving up on
Linux. When Ubuntu came around,
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I looked into and followed it. Linux
support for Apple hardware at the
time was not very good. It wasn't
until 10.04 that I was able to install
it on a spare drive on my MacBook
with almost no issues. My MacBook
was starting to develop an
overheating problem, which was
minor when running OS X but was
worse under Linux. It was enough
to see that I could use it for my
day-to-day needs.
These days, I am one of the
many IT professionals forced to
work in a lousy job due to a lack of
work in my area of expertise. My
idea is to try to build a small
business—installing and
supporting Ubuntu for ordinary
people who are fed up with viruses
and spyware, or who have decent
hardware but still can't run the
latest and greatest versions of
Windows. Not an easy goal, but I
feel it is worth trying. To this end, I
was able to get a new Acer
computer, and I am running
Quantal Quetzal and loving it.
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MY OPINION
Written by Robin Catling

W

ith time to let the dust
settle and reflect on the
bust-up between Canonical and
some parts of the Ubuntu
community, what can we really say
about the state of relations
between the sponsor and its
contributors?
Last month, Canonical caused
some upset by unveiling its Project
X, the new compositing and
rendering engine, Mir, turning
away from Wayland, which Mark
Shuttleworth had been supporting
for the best part of two years.
Mir will be a substantial
technical prop for Ubuntu across
devices and platforms, as
Canonical seeks commonality of
code and toolkits for development.
However, not only is Mir looking
somewhat proprietary, but the
nature of the announcement, and
the revelation that Mir was
developed under wraps for nine
months, has caused some friction
within the community—to say the
least.
Suddenly, the Ubuntu Council,

project leaders and
developers—basically anyone
outside the hallowed portals of
Canonical—have to question what
they are and aren't “allowed” to
contribute, and whether or not
that contribution has any value or
place in the increasingly
centralised and less Open Source
Ubuntu OS. Community Council
member Elizabeth Krumbach asked
that very question in a very
reasonable blog post.
With one notable project
leader, Jonathan Ridell, effectively
resigning his Ubuntu Member
status, Shuttleworth then made
things worse by going on the
attack instead of taking it on the
chin—accusing Ridell of 'divisive
leadership.' Call it toy-throwing or
blatant hypocrisy, this may go
down as the 'Benevolent Dictator
for Life's shark-jumping moment,
proving that the words
'benevolent' and 'dictator' simply
cannot sit side-by-side.
Now join the dots to another
announcement which went out last
month.
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No one doubts Canonical's
ambition and drive to get Ubuntu
onto as many devices as possible,
even to the extent of working with
the Chinese state. Canonical is
working with the Chinese
regulators to get a version of
Ubuntu certified for public use. For
now, let's just say that however
you try to dress that up, software
freedom and the People's Republic
of China do NOT go together.
What this adds up to is a
double-whammy of
disappointment if you were
marching behind Canonical as a
beneficent flag-bearer for
community-driven development
and software freedom.
At the risk of repeating myself,
however, I'd like to emphasise that
Canonical is a commercial entity.
Although it has a long way to go to
reach the level of Oracle Corp in its
single-minded pursuit of the dollar,
as a commercial venture, Canonical
needs to get product out to
consumers to make money.

Ross, in attempting to explain and
excuse Canonical's behavior,
likened Ubuntu to a multi-stage
rocket in which we all play a part in
reaching for the stars. I say
unfortunate because many
contributors chose to see their
efforts jettisoned with the booster
rockets as the Canonical command
module blasts onward to new
worlds.
Whether or not Canonical's
Apple-esque attempt to build its
own controlled and exclusive
framework for Ubuntu succeeds,
whether or not the rocketship
reaches its destination, the rest of
us have to accept that a
commercial sponsor reserves the
right to put its money where it
chooses. You can follow the
money, or go with the community.
That's just the way it is.

It was unfortunate that Randall
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BOOK REVIEW

Book Of GIMP

Written by Ronnie Tucker

Publisher: No Starch Press
Pages: 676
January 2013, 676 pp.
ISBN: 978-1-59327-383-5
http://nostarch.com/gimp

I

f you’ve always wanted a full
manual for GIMP, then The Book
of GIMP is about as close as you’ll
get. Covering GIMP 2.8 and almost
every feature of it, you’ll be a GIMP
master in no time.
The book starts with learning
the basics, such as the screen
layout (single window FTW!),
opening and resizing images, using
layers, and how to use a graphics

tablet in GIMP. After that, it’s into
the deep end with photograph
retouching stuff like cloning, color
correction, and restoration.
“Drawing and Illustration” comes
next, including using the
paint/pencil tools, shapes, fills and
much more. “Logos and Textures”
is a short chapter which is followed
by composite photography, where
you’ll combine several photos into
one. Chapter 6 even covers
animation in GIMP which I was
surprised to see. Same with using
GIMP to design a website (Chapter
8).
Having survived Part One,
you’re thrust into Part Two, which
goes into the features of GIMP in
more depth—such as showing you
layer masks, layer blending modes,
tools, and filters. Even dipping into
things like scanning, installing
plug-ins (such as the awesome
G’MIC) and then customizing your
GIMP interface.
Part Three (the finale) is
interesting in that it gives some
good information on how the
human eye works regarding vision,
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perception and color
representation. I thought that was
a nice touch.
I really can’t fault The Book of
GIMP. It’s well laid out, tells you
exactly where you need to go in
the menus (for example: Image:
Edit > Copy), gives you the
keyboard shortcut where possible,
and has plenty of screenshots of
where you’re going. The book is
certainly no short read as it’s about
two inches thick with almost 700
pages! Of course, if you buy the
book from No Starch Press (the
publishers) they also give you
access to a digital (PDF) copy of
the book, which is nice.
If I had to pick one down-side, it
would be that some examples look
quite amateurish and simplistic
(such as combining photographs to
create something completely
unrealistic), but I suppose this
book is for beginners and not
those who want to create the next
skin perfect magazine cover.
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REVIEW

SolydXK

Written by Art Schreckengost

E

ver hear of SolydX or SolydK
or the conjoined SolydXK?

You can stop scratching your
head, these aren’t cereals or highfiber colon cleansers. The first two
are Debian based distributions
with Xfce and KDE as desktop
choices. At 950 MB and 1.4 GB
respectively, these are just slightly
larger than the Debian parent that
bore them.

Lack of history aside, I was able
to get an .iso image of each for a
try in my Virtualbox setup.
While the installer is more
aesthetically pleasing than
Ubuntu’s, some may find it
confusing when it comes time to
pick the root partition and related
format. If that sounds a little out
of your league, there is a helpful
tutorial at

http://solydxk.com/community/tut
orials/#software.
Even with the usual Virtualbox
bottleneck and slowdowns,
installation was not bad at roughly
20 to 30 minutes for either. No
updates awaited me, and this I
attribute to the Debian
underpinnings and the
youthfulness of the OS itself
(about 3 months old when I got it).

Footprints were relatively low at
less than 10 GB for either, once
installed.
In what has to be a rarity, all my
hardware was recognized and I
experienced no problems with
video, audio, or anything
else—since nearly every codec or
driver you’d need is already there.
If it won’t play or open, chances are
your files are woefully outdated.
As for desktop designs, you get
either the very basic Xfce or the
somewhat more grandiose KDE. If
you didn’t catch the hints, I’m
referring to Xfce’s rather bland
“here it is, take it or leave it” 2D
qualities, or KDE’s “add enough
widgets and you’ll never see that
desktop again” design issues.

Still doesn’t ring a bell? Well,
they are new (early 2013 or so),
and, other than a sparse website at
http://solydxk.com, there really
isn’t much to indicate they really
exist. Perform an online search and
you’ll see results highlighting a
window tinting company, the
actual website, and a couple notes
that no such words exist (in that
order, I might add).

In base form, both look
somewhat alike with similar
backgrounds and bottom taskbars.
Probably to aid users in
identification, there is a big X or K
in the titles of each, good thing
since they are nearly
indistinguishable otherwise. Take a
look at the screenshots and you’ll

And what of SolydXK? It’s a
teaser that exists in name only at
this point. It’s X or K but not XK
quite yet, although I see no reason
you couldn’t install Xfce and then
add KDE or vice versa.
full circle magazine #72
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see what I’m referring to.
That’s it folks. Other than the
ubiquitous KDE musical ditty upon
opening (Xfce has no such
announcement), you’d be hard
pressed to tell the difference,
although KDE aficionados would
spot the standard transparent
window and widget menu
immediately. Taskbars for both are
the same layout, too, with the
menu to the left and system
information parked to the right. As
the adage goes, if it ain’t broke
don’t fix it.
About the only other indicator
of one over the other is KDE’s
better clarity and brightness. Xfce
looked downright dull in
comparison, but it is a lightweight
desktop design with a minimum of
flash.
Normally, I’d steer users with
limited resources to the Xfce
platform since it usually performs
much faster than the fatter KDE
offering; however, that’s not the
case here. In fact, it wasn’t really
close. KDE was a good 5 seconds
faster to boot—even after adding
desktop widgets that would
normally cause it to crawl.
However, I don’t consider Xfce’s

average boot time of 30 seconds
anything to laugh about, especially
given that’s in Virtualbox.
Being lightweight usually comes
with a price, and that’s often a
spartan menu with equally spartan
tools, but that isn’t the situation
here.
A partial listing is shown in the
table bottom right.
While boot times were
definitely different between the
two, there was no discernible
difference in performance beyond
that. Both were equally quick in
opening programs and files, saving
documents, etc. If nothing else,
either version of Solyd was quite
fast once booted, even when using
Live mode in Virtualbox.
About the only bottleneck I
encountered was the ever
troublesome Software Manager,
which resembles the Ubuntu
Software Center—minus the
branding and Canonical
commercial offerings. It frequently
did spooky things like flutter in and
out during program installation, or
just lock up for no good reason. On
the other hand, the old standby,
Synaptic Package Manager,
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performed like a champ.
So, would I recommend either
one? All depends upon what you’re
after. Those looking for a stable
Debian based distribution will be
well served here, but being plain
can lead to problems.
First, it doesn’t stand out from
the crowd. Remove the name and
artistic logs and it could be
confused with a couple dozen
offerings I’ve reviewed over the
years. The base programs are just
that—base. It has no specialty,
such as Peppermint OS and their
Cloud-based programming, nor
does it appeal to a segment, such
as ArtistX or openArtist—two
distros with a bevy of programs
geared to A/V artists.

even though they are quite
capable.
But there is no faulting the OS
itself. It has never failed to work,
and I have yet to induce a crash
(and believe me, I do try hard). It
just needs to be polished a bit
more with some excitement added.
Mind you, don’t go all Cadillac
Cimaron on it, just add some
pizzazz (Google that Cadillac, if the
name doesn’t ring a bell, and you’ll
see what I mean).
With all these factors
considered I give SolydX and
SolydK 3 out of 5 stars.

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.
The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Second, is it going to survive or
become relegated to the dustbin
of history? Take a look at
Distrowatch, and, once you get
past the top 50, you’ll see a few
hundred more releases that just
never made the popularity polls

Full Circle Podcast
Episode 33, With
Added Horsepower
Your hosts:
• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark
and Freaky Clown
from the
Blackpool (UK) LUG
http://blackpool.lug.org.uk
In this episode we are joined
by Freaky Clown, we talk
about the Ubuntu Phone
release, Linux peripherals
and some events.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.
podcast.ubuntu-uk.org
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LETTERS

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .

PLEASE NOTE: some letters may be edited for space.

CINNAMON MINT

I

'm sure you've seen enough
complaints from people who
don't like the constant fiddling
with the user interface for Ubuntu.
I won't rehash those arguments.
Instead, I will point out that Mint is
one of the top Debian
distributions, and ask if the reason
might be a consistent user
interface?
Ubuntu could reclaim its place
at the top, and satisfy those who
want a consistent user interface,
by creating a desktop.conf file
which would store the user's
choice for backdrop, desktop
theme, and all the other elements
of the look-and-feel which I could
adapt to, but I don't want to have
to adapt to.

FULL CIRCLE READER SURVEY 2013
It's that time of the year again folks. That time
where we offer you, the readers, a say in the
future of Full Circle.
All we ask is that you fill in as much detail as
you can on the survey we've written up at
http://goo.gl/hR7zc
That's it!
We'll gather together the data and present our
findings in a future issue of Full Circle for all to see.

Join us on:
goo.gl/FRTMl
facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE NEEDS YOU!
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See page 25 to read our basic
guidelines. Follow those and
you're almost guaranteed
success.

Come May, 10.04 LTS will be
expiring, and I'm planning to go to
Cinnamon Mint. I'd rather stay with
Ubuntu, but only if they quit
forcing a new user interface on me.

Have a look at the last page (of
any issue) to get the details of
where to send your
contributions.

Thomas M. "Toad" Brooks
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Q&A

If you have Ubuntu-related questions, email them to:
questions@fullcirclemagazine.org , and Gord will answer them in a future
issue. Please include as much information as you can about your problem.

Compiled by Gord Campbell

When I delete a file in
Q Dropbox,
is it really gone
forever, everywhere?

A

No! Jens (FCM Mobile
Edition) pointed out that if
you log on to the Dropbox web
interface, and open the folder
where the file used to reside, you
can click on an icon labelled "Show
deleted files." If you right-click on a
deleted file, you get the option to
restore it. I have yet to figure out
how long it remains there.

When I open Home Folder
Q from
the Unity Launcher, the
left side panel (Devices, Computer,
Network) is missing. How do I get
this to display again?

A

(Thanks to DuckHook in the
Ubuntu Forums) Press <F9> to
toggle the sidebar.

A

(Thanks to cortman in the
Ubuntu Forums) As far as
Ubuntu/Canonical is concerned, it
means they'll provide security
updates and bug fixes for that
version for an extended period.
Beginning with 12.04, that period
is five years for Ubuntu Desktop.
Also note that beginning with
13.04, "standard" releases will be
supported for nine months.

Q What is Mir?

A

http://www.omgubuntu.co.uk
/2013/03/canonical-announcecustom-display-server-mir-notwayland-not-x
https://wiki.ubuntu.com/MirSpec

tried hardinfo, and while
Q itI just
provides lots of information,
it doesn't have the level of detail
that I want.

What does “long term
Q support”
mean to the average
user?

A

If you want a detailed
description of your hardware,
open Terminal and paste this
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command:
sudo lshw -html >
Desktop/myconfig.htm

If you double-click on
myconfig.htm, it should open in
your browser, and give you a nicely
formatted report about your
hardware.
Is there a way to enable
Q automatic
login when I didn't
select it at installation?

A

If you click on the dash and
type login, do you see "login
window" as something you can
run? If so, select the Security tab,
and "Enable Automatic Login" is a
checkbox item.
Or, it might be under "User
Accounts", where you click on
"Unlock", provide your password,
then flip the "automatic logon"
switch.

Is there an equivalent
Q program
to Sysprep for
40

Windows? I want to set up systems
which are ready to use, then when
each end-user powers up the
computer for the first time, he
would be asked to provide a
username, password, etc.

A

(Thanks to Cheesemill in the
Ubuntu Forums) When you
boot the installation media, hit
SHIFT to get to the installation
menu, then hit F4 and select 'OEM
Install'. When Ubuntu has finished
booting, install the system as
usual, you will be prompted for a
temporary username and
password.
When installation has finished,
boot the system and log on with
the temporary username and
password you created earlier; you
can now make any other
alterations to the system that you
want, for example getting updates
and installing extra software.
(Corporate wallpaper!) When
you're all done, just double-click on
the 'Prepare for shipping to end
user' icon on the desktop and then
shut down the machine. You can
take an image of the drive, and
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install that on as many computers
as you want.
I recently installed Xubuntu,
Q but
I like Nautilus better than

message.
Ubuntu 12.04 installed
Q onI have
a Panasonic Toughbook CF-

Thunar, so I installed Nautilus. Now
what?

29 with a built-in GPS device. The
GPS device does not show up in
lshw.

A

A

(Thanks to LewisTM in the
Ubuntu Forums) Go to
Settings -> Preferred Applications
-> Utilities, and set the File
Manager to Nautilus.

I received an email which
Q caused
Evolution version 3.2.3
to go into a CPU loop. I can't even
delete it!

A

You can fix the email. Set
your file manager to show
hidden folders, and navigate to
.local/share/evolution/mail/local/c
ur
Each email message is a file.
The time and date on the file will
not match the email's time and
date exactly, but it should get you
close. Open the file in Gedit, and
find the first thing which is not
simple text. Delete from there to
the end, restart Evolution, and you
should be able to delete the

(Thanks to xraynetcontrol in
the Ubuntu Forums) (Gord
says: The GPS appears to be a serial
device attached to what MS-DOS
calls a COM port.) I needed to add
myself to the "dialout" group. I did
that by entering this into the
terminal, and then rebooting the
box:
sudo adduser (name) dialout
sudo dpkg-reconfigure gpsd

Since my laptop has an actual
serial port on the back, I guessed
that the GPS receiver was in serial
slot 2, so I entered ttyS2, and kept
everything else as a default.
So, enter:
stty -F /dev/ttyS2 ispeed
4800 && cat </dev/ttys2
xgps
cgps

It took about 5 minutes to get a
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2D lock on me, as I was inside. I
closed out the terminals and
launched a variety of GPS
programs like GPSDrive, FoxTrot
and Viking. All worked as expected.

TIPS AND TECHNIQUES
You want to run a web server?

I

frequently see questions from
people who want to set up a
website running on a home
computer, typically stated as, "I set
up a website on my computer, but
it doesn't work. Please help."
Instead of saying, "it doesn't
work," tell us exactly what you
have done and what happens as a
result. For example:
I have confirmed that my ISP
allows customers to run a web
server. (Many don't, so that's the
end of it!)
I have purchased the static IP
address 1.2.3.4 from my ISP. (It's
possible to run a web site without
a static IP address, but you're
getting into "how to build a pocket
watch in 394 easy steps" territory.
Hint: dyndns.)
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I have purchased the domain
iamtank.com from the registrar
Somereg, and have pointed it to
1.2.3.4 (probably the easiest step).
My server is set up with a static
IP address on my LAN, and it is
192.168.1.32 (See last month's
Q&A for setting up a static IP
address on your LAN.)
I have set up my router to
forward port 80 to 192.168.1.32
(The router's manual will tell you
how.)
I am running Apache on my
server, and other computers on the
LAN get the web page when I
enter 192.168.1.32 into a browser
address bar.
Actually, if you have done all
those things, it should work.
Be specific! Don't say
mydomain.com, tell us your actual
domain name, tell us your IP
address.
There is a lot of information on the
Internet. For example, 30 seconds
on Google revealed this page:
http://net.tutsplus.com/tutorials/p
hp/how-to-setup-a-dedicated-webserver-for-free/
contents ^
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Top 10 Greenlight Games

Written by Jennifer Roger

S

team (Valve’s very successful
game client) has been around
for a while, but it’s been only a few
months since Ubuntu users have
had the pleasure of getting an
official client. Now Linux gamers
can get in on the democratic
service known as Greenlight.
Steam’s Greenlight allows
developers to submit their
games—so that players may upvote the games they want to see in
the Steam store. So which games
stand out the most? Here are my
top-ten picks of Linux games
waiting for the Greenlight on
Steam.

C-WARS

C-Wars is a fast-paced real-time
strategy game that draws from a
few different styles. Years after a

devastating nuclear war, survivors
take refuge on the Moon—only to
discover an unknown substance is
turning humans into zombies. You
and your companions must fight
another battle to save the new
civilization from extinction.

TRACE VECTOR

With fast-paced gameplay and
lots of neon colors, Trace Vector
reinvents the retro arcade game by
combining old school vector
graphics with simple gameplay
that progressively becomes more
challenging. Players must navigate
their ship through winding
geometric levels, while collecting
fuel to stay the course. With action
and puzzle elements, Trace Vector
looks to be an addicting blast from
the past with a modern twist.

DELVER
Delver is a first person
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roguelike with some innovative
ideas. It draws inspiration from
games like Ultima Underworld, and
combines traditional elements of a
roguelike, but the gameplay and
graphics give it a new twist.
Although still in development,
there are already lots of great
features with more to come, such
as character classes and a dungeon
level editor.

FORCED

Battle through gladiator-style
trials in this tactical co-op RPG.
Forced highlights the cooperative
aspect with features like the Spirit
Mentor which challenges players
to work together to control an
42

extra party member with special
abilities and an ethereal form. The
trick is that they must be
controlled simultaneously, so
teamwork is a must. Of course
there are also epic boss battles
and plenty of skills to unlock as
you fight your way through over 30
trials in the game. To give it a try
and join the online beta, visit
forcedthegame.com

AEON COMMAND

Aeon Command is a strategy
warfare game set in a space battle
between three factions of Aeon
Nebula. Choose between the
Alliance, Exiles, and Cyborgs in the
struggle for control of the Aeon
Nebula. Each faction has its own
distinct abilities, ships, and
campaign with eight missions.
There are also skirmish modes, and
multiplayer, along with numerous
upgrades to help improve your
fleet.
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LEGEND OF DUNGEON

Robot Loves Kitty’s latest
project, Legend of Dungeon, is a
roguelike dungeon crawler that
dares players to embark on a
dangerous mission to retrieve a
mysterious treasure from the 26th
floor of a dungeon. You, and up to
three companions, are on a quest
to do what no one else has done
before—find the fabled treasure
and successfully return from your
journey. Legend of Dungeon
features randomized dungeons
and various puzzle elements for an
added challenge. The game is
currently in its alpha stage and
available to demo at
robotloveskitty.com/LoD/

SENTINEL

Sentinel is a gorgeous tower
defense game with interactive
music elements. The game is set on
a sequencer grid as you activate
different new parts of the
soundtrack in time with the music,
all while adding defenses and
destroying enemies. Inspired by
other music games like Rez and
Lumines, the creators of Sentinel
have found a beautiful new way to
play a tower defense game.

looking for even more battles and
loot, there is also mod support to
edit and create your own levels. A
demo of the beta is available for
free at hammerwatch.com

CHASM

HAMMERWATCH

Fans of the Gauntlet series will
love Hammerwatch, a fast-paced
hack and slash action adventure
from Jochum Skoglund and Niklas
Myrberg. There are four character
classes to choose from as you
battle through hordes of enemies
and solve puzzles within Castle
Hammerwatch. In addition to a
single player campaign, players can
play with up three friends in local
co-op or online multiplayer. There
are a total of twelve levels divided
among four acts, but if you’re
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It can be difficult to draw from a
lot of different things and do it
well, but Chasm is a game that
successfully blends many different
elements to create an innovative
gameplay experience. Part 2D side
scrolling platformer and part
action RPG, you play as a weary
soldier heading home from a long
war. While passing through a
mining town, you discover that its
citizens have accidentally
awakened an ancient evil.
Supernatural forces have trapped
you in the town, and now you must
battle to escape and return home
safely. With gorgeous graphics and
an engaging story, Chasm looks to
be a game to keep an eye on.

LEGENDS OF AETHEREUS
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Gamers looking for highly
dynamic gameplay and epic world
will be thrilled to try Legends of
Aethereus. Set in a world after the
Third Great Skyfall, you must
battle to help restore peace and
banish the evil that vies for power.
With three unique classes (officer,
astrographer, and inventor), you
can play the single player
campaign or engage in PVE or PVP
arena battles. In addition to
exploring a lush, beautiful world,
depth and customization is a
central theme with the game. The
addition of a crafting system adds
vast combinations of customizable
items, and the statue and banner
creators allow you to personalize
your city-state. Legends of
Aethereus is currently in beta.

Jennifer is a writer, gamer and geek,
hailing from the Chicagoland area.
You can follow her on Twitter
@missjendie or visit her website at
indiegeekery.com.
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LINUX CERTIFIED

Written by Richard Philip Witt

C

all me pernickety, but when I
use ls, I prefer my files listed
vertically not horizontally. Most of
the time anyway. ls -1 lists
vertically, one file or folder per
line. (I’m salivating as I write.); but I
don’t want to write ls -1 each time.
So what can I do? Use the alias
function. It's very simple, and also
on the LPIC 1 Exam 101 syllabus.*
alias forms new commands or
modifies existing commands, the
latter relevant here. But first:
which aliases (aliai?) already exist?
rpwitt@rpwittlaptop:~/Documents/programmin
g$ alias
...
alias l='ls -CF'
alias la='ls -A'
alias ll='ls -alF'
alias ls='ls --color=auto'

In my case (Ubuntu 12.04 LTS),
ls comes preset with the alias 'ls -color=auto', which, as far as I know,
assigns different texts colours to
directories, files, symlinks and the
like. Hence, it was all the more
pertinent for me to check the
existing aliases before making any
changes. Assigning a new alias
would overwrite this existing one,

losing my colour coded files and
folders, and most probably
throwing me into some deep funk
for the weekend.
To have one file or folder per
line yet keep the colour coding:
(N.B. Although not always
necessary, it’s good practice to set
your alias commands inside
apostrophes)
alias ls='ls -1 --color=auto'

Execute the command.
rpwitt@rpwittlaptop:~/Documents/programmin
g$ ls
c_programming.pdf
lfs.pdf
LinuxAdm.pdf
linux_nutshell.pdf
lpic.pdf
nand2tetris
prog_interface.pdf
shell_scripting.pdf

And there she blows.

want my folders listed first. A quick
consultation under ls --help
informs me that ls --groupdirectories-first will get the job
done. I can have all I would have
hoped (and still do ever hope) for.
If only I wouldn’t have to type that
pesky addendum to each ls
command: --group-directories-first.
alias saves the day again.
alias ls='ls -1 --color=auto
--group-directories-first'
rpwitt@rpwittlaptop:~/Documents/programmin
g$ ls
nand2tetris
c_programming.pdf
lfs.pdf
...

It's a beautiful sight.

*The alias command is a part of
LPIC learning statement 1.105.1,
Customize and use the shell
environment. (weight: 4)

But wait! It's not enough. I want
to have my nand2tetris folder (very
cool little learning project) at the
top of that list. In fact, I always
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Richard Philip Witt, 30, living in
Switzerland. I’ve been using Ubuntu
desktop and server for roughly 2
years. But only for the basics. Now I
want to discover its capabilities. Any
mentors out there? Email me:
chilledwinston2@hotmail.com.
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MY DESKTOP

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

My current setup could be described as low-key, with cold
colors and little visual clutter to hamper me at my work. It is
actually the Xubuntu 12.10 XFCE4 desktop with a few
modifications: docky at the bottom, conky discretely at work
to the right, and a beautiful mist-themed wallpaper below. It
uses only 230 MB of RAM at startup.

I'd like to submit this screenshot from our main desktop
computer running Voyager Linux 12.04 (based on Xubuntu),
Xfce, Docky, and a customized Conky.

Alan Ward

David Burke
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MY DESKTOP

My main computer is an ASUS X57VM50VN notebook with
an Intel Core 2 Duo T9400 processor, 4GB of RAM, and a
nVIDIA GeForce 9650m graphics card. I bought that
machine in 2009. I run Ubuntu 12.04.2 LTS and gnome3
with some shell extensions such as weather, updates,
another user menu, and so on. As you can see on the
picture, I run conky, displaying some information on my
system and network. The background image is a picture I
have taken in the valley of the river Pockau near the village
Ansprung in Saxony.

This is my recent KDE desktop in Ubuntu 12.04.2 LTS. You can see
conky, rainlendar 2.10, and covergloobus as a music widget.
Operating System: Ubuntu 12.04.2 LTS
Desktop Environment: KDE 4.8.5
Icons: KFaenza
CPU: Intel Core 2 Duo 3.02 GHz
RAM: 2 GB
HDD: 500 GB

E. Frank Sandig

Maikel
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Full Circle Team

HOW TO CONTRIBUTE

Editor - Ronnie Tucker

FCM#73

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline:
Sunday 12th May 2013.
Release:
Friday 31st May 2013.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Lucas Westermann,
Gord Campbell, Robert Orsino,
Josh Hertel, Bert Jerred
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:
EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org
Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app) and
you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.
Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full
circle', choose an issue, and click the download button.
Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.
Ubuntu One - You can now have an issue delivered to your free Ubuntu One space by clicking the 'Send to Ubuntu One' button
which is available on issues 51+.
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